
CHÖÔNG XII. 
CHOÏN VAØ TÌM KIEÁM THOÂNG TIN TREÂN BAÛN ÑOÀ SOÁ

Trong caùc chöông tröôùc, chuùng ta ñaõ xem xeùt qua moät soá öùng duïng cuûa baûn ñoà soá
trong MapInfo, nhö vieäc taïo baûn ñoà, xem thoâng tin, trình baøy baûn ñoà,v.v. Trong chöông
naøy chuùng ta seõ xem xeùt chöùc naêng tìm kieám thoâng cuûa baûn ñoà soá trong MapInfo. Khaû
naêng tìm kieám vaø phaân tích thoâng tin laø moät trong nhöõng ñieåm maïnh cuûa baûn ñoà soá.
Chính phaàn naøy laø öu theá raát lôùn cuûa baûn ñoà soá so vôùi baûn ñoà giaáy thöôøng.

XII.1. CHOÏN THOÂNG TIN

Caùc leänh choïn trong MapInfo naèm trong menu chính Query.

XII.1.1. Leänh Select (Choïn)

Select laø leänh choïn cuûa MapInfo.

Khi choïn Query > Select, hoäp thoaïi Select seõ môû ra (hình XII.1). Hoäp thoaïi bao goàm
caùc noäi dung nhö sau:

- Select Records from Table: teân baûng caàn choïn döõ lieäu. Neáu choïn muõi teân thaû xuoáng
trong haøng naøy thì MapInfo seõ lieät keâ danh saùch caùc baûng ñang môû cuûa MapInfo.

Hình XII.1. Naïp bieåu thöùc choïn trong hoäp thoaïi Select.
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Ta phaûi choïn teân baûng mình muoán laáy döõ lieäu ra. Neáu ta ñaõ thöïc hieän pheùp choïn
tröôùc ñoù thì phaàn naøy lieät keâ caû caùc pheùp choïn ñoù ôû daïng queryn.

- that Satisfy: hoäp thoaïi naøy cho pheùp ta ñöa ra tieâu chuaån ñeå thöïc hieän pheùp choïn.
Tieâu chuaån thöïc hieän pheùp choïn ñöôïc theå hieän baèng Bieåu thöùc. Ta coù theå söû duïng
nuùt Assist ñeå taïo bieåu thöùc.

- Store Results in Table: oâ naøy cho MapInfo bieát teân baûng chöùa keát quaû tìm ñöôïc. Maëc
ñònh laø tuyø choïn Selection. Neáu giöõ nguyeân tuyø choïn naøy thì pheùp choïn seõ taïo rang
moät baûng ñöôïc ñaët teân maëc ñònh laø Queryn, trong ñoù n laø moät con soá. Neáu ta thöïc
hieän pheùp choïn laàn ñaàu tieân keå töø khi khôûi ñoäng MapInfo thì n = 1, neáu ta thöïc hieän
leänh Select naøy laàn thöù hai thì n = 2,... Neáu ta thay Selection baèng moät teân naøo ñoù
thì baûng taïo thaønh seõ coù teân do ta ñaët trong haøng naøy.

- Sort Results by Column: haøng naøy cho pheùp ta saép thöù töï keát quaû choïn theo moät coät
naøo ñoù trong baûng.

- Load Template/Save Template: Bieåu thöùc choïn sau khi ñöôïc thöïc hieän xong trong
hoäp thoaïi naøy coù theå ñöôïc löu laïi baèng leänh Save Template vaø laàn sau khi muoán
thöïc hieän laïi pheùp choïn naøy ta khoâng phaûi goõ laïi maø coù theå duøng leänh Load
Template ñeå goïi pheùp choïn ñoù ra.

Löu yù raèng trong pheùp choïn khi goõ con soá, khoâng ñöôïc goõ vaøo daáu phaân caùch haøng
nghìn. Ví duï neáu ta goõ 20000 laø ñuùng nhöng neáu ta goõ 20,000 laø sai.

Ta seõ xem xeùt moät soá ví duï cuûa leänh naøy.

Ñeå ví duï ta seõ söû duïng baûng cac_tinh. Khôûi ñoäng MapInfo, môû baûng cac_tinh ra.
Trong baûng naøy coù theâm hai tröôøng nöõa laø dien_tich vaø dan_so trong chöông.

Ví duï 1: Pheùp choïn ñôn giaûn
Giaû söû ta muoán choïn ra taát caû caùc tænh coù dieän tích nhoû hôn 5000 km vuoâng. Caùch

laøm nhö sau:
+ Choïn Query > Select; hoäp thoaïi Select môû ra.
+ Trong Select Records from Table ta choïn baûng caùc_tinh
+ Nhaép chuoät vaøo hoäp that Satisfy roài choïn nuùt Assist; Hoäp thoaïi Expression môû ra
+ Baám chuoät traùi vaøo nuùt muõi teân thaû xuoáng trong oâ Column choïn tröôøng dien_tich.
+ Baám chuoät traùi vaøo oâ Operators choïn daáu nhoû hôn (<).
+ Di chuyeån chuoät trôû laïi hoäp that Satisfy vaø goõ vaøo sau daáu nhoû hôn con soá 5000.

Coù theå choïn nuùt Verify ñeå kieåm tra bieåu thöùc (khoâng baét buoäc). Neáu hoäp thoaïi
MapInfo hieän ra doøng thoâng baùo “Syntax is correct” (cuù phaùp ñuùng) thì coù nghóa
laø ta ñaõ goõ ñuùng cuù phaùp bieåu thöùc. Löu yù raèng cuù phaùp ñuùng khoâng coù nghóa
laø pheùp choïn ñöa ra keát quaû ñuùng. Keát quaû ñuùng hay sai phuï thuoäc vaøo bieåu
thöùc ta naïp vaøo ñuùng hay sai.

+ Laøm xong choïn OK ñeå quay laïi hoäp thoaïi Select.
+ Trong haøng Store Results in Table ta coù theå goõ tieâu ñeà choïn keát quaû, ví duï ta goõ

“dt_nho_hon_5000”; löu yù raèng teân trong oâ naøy khoâng ñöôïc coù khoaûng
traéng, neáu ta goõ khoaûng traéng MapInfo seõ töï ñoäng thay noù thaønh gaïch noái vaø
hieån thò doøng thoâng baùo “Table name has been changed to a valid indentifier.”
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+ Ta coù theå xeáp thöù töï keát quaû baèng haøng Sort Results by Column, ví duï ta choïn
laø tröôøng ten.

+ Ñaùnh daáu choïn vaøo oâ Browse results.
+ Choïn OK.

Trong vaøi giaây ta seõ thaáy hieän ra danh saùch caùc tænh coù dieän tích nhoû hôn 5000 km
vuoâng, ñoàng thôøi caùc tænh ñoù cuõng ñöôïc choïn treân cöûa soå baûn ñoà.

Töông töï nhö vaäy ta coù theå söû duïng caùc toaùn töû, haèng soá,... ñeå thöïc hieän pheùp choïn
ñôn giaûn nhö treân.

Ví duï 2: Pheùp choïn phöùc taïp hôn

Ví duï ta muoán choïn caùc tænh coù dieän tích nhoû hôn 5000 km vuoâng vaø coù daân soá lôùn
hôn 800 nghìn ngöôøi. Caùch laøm hoaøn toaøn töông töï nhö treân chæ coù ñieàu bieåu thöùc trong
oâ that Satisfy seõ laø “dien_tich < 5000  And  dan_so > 800” (ñôn vò tính trong
coät daân soá laø nghìn ngöôøi), xem hình XII.2.

Ví duï 3: pheùp choïn söû duïng caùc keát quaû tính toaùn töø caùc coät khaùc nhau

Giaû söû ta muoán choïn caùc tænh coù maät ñoä daân soá nhoû hôn 150 ngöôøi/km vuoâng. Ta
bieát raèng maät ñoä seõ baèng soá daân chia cho dieän tích. Vì vaäy ta seõ söû duïng hai tröôøng
dan_so vaø dien_tich ñeå thöïc hieän pheùp choïn naøy.

Bieåu thöùc ñeå thöïc hieän pheùp choïn naøy ñöôïc goõ vaøo oâ that Satisfy seõ laø:

Hình XII.2. Choïn vaät theå theo tieâu chuaån töø nhieàu tröôøng (Select).

Hình XII.3. Choïn vaät theå theo tieâu chuaån tính toaùn töø caùc tröôøng khaùc nhau.
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“(dan_so*1000/dien_tich)<150”. Giaù trò trong coät daân soá phaûi nhaân cho
1000 vì ñôn vò tính daân soá trong coät ñoù laø 1000 ngöôøi. Hoäp thoaïi Select seõ coù noäi dung
nhö treân hình XII.3.

XII.1.2. Leänh SQL Select

Ta ñaõ thaáy raèng trong phaàn Select ta coù theå thöïc hieän pheùp choïn caùc döõ lieäu töø
baûng MapInfo tuyø theo caùc yeâu caàu trích xuaát thoâng tin töø moät baûng lôùn. Caùc tieâu
chuaån choïn ñöôïc theå hieän trong bieåu thöùc. Tuy nhieân leänh Select vaãn coù moät soá haïn
cheá, ví duï nhö ta chæ coù theå choïn döõ lieäu döïa theo caùc tieâu chuaån choïn töø moät baûng
maø thoâi. Giaû söû muoán choïn döõ lieäu töø moät baûng nhöng caên cöù theo tieâu chuaån choïn töø
döõ lieäu cuûa moät baûng khaùc. Trong tröôøng hôïp ñoù ta phaûi söû duïng SQL Select.

SQL laø chöõ vieát taét cuûa Structured Query Language (ngoân ngöõ truy vaán coù caáu truùc).
SQL thöïc chaát laø moät caùch truy xuaát döõ lieäu ñoäc laäp coù töø laâu trong caùc cô sôû döõ lieäu
khaùc, tröôùc khi MapInfo xuaát hieän. Pheùp choïn SQL laø moät pheùp choïn duøng ñeå truy xuaát
nhöõng thoâng tin caên cöù theo nhöõng tieâu chuaån choïn “cao caáp” hôn leänh Select. Baûn
chaát SQL thöïc ra cuõng laø moät ngoân ngöõ truy vaán phöùc taïp. Trong phaàn naøy ta seõ xem
xeùt nhöõng tính chaát cuûa leänh SQL Select trong MapInfo.

Leänh SQL Select trong MapInfo coù caùc ñaëc ñieåm chính sau:

- Coù theå choïn döõ lieäu theo tröôøng.

- Coù theå söû duïng bieåu thöùc ñeå taïo ra moät coät khaùc.

- Trong moät pheùp choïn SQL coù theå söû duïng nhieàu baûng khaùc nhau.

- Döõ lieäu truy xuaát ñöôïc coù theå ñöôïc goäp nhoùm laïi tuyø theo moät hay nhieàu thuoäc tính
chung naøo ñoù.

- Caùc toaùn töû ñòa lyù cuõng coù theå ñöôïc söû duïng ñeå thöïc hieän phaân tích theo khoâng gian
ñòa lyù giöõa caùc lôùp khaùc nhau.

Vieäc söû duïng leänh Select ñaõ ña daïng thì vieäc söû duïng SQL Select coøn ña daïng vaø
phöùc taïp hôn. Thöïc chaát khi söû duïng caùc leänh naøy chuùng ta caàn naém vöõng caùc kieán
thöùc cô baûn veà toaùn hoïc vaø bieát caùch phaân tích baøi toaùn döõ lieäu caàn giaûi quyeát, ñöa lôøi
giaûi vaøo MapInfo thoâng qua nhöõng leänh treân chæ laø phaàn hình thöùc.

Trong phaàn naøy, khoâng theå ñöa ra baát cöù moät phöông phaùp toång quaùt naøo cho
nhöõng leänh naøy vì vieäc söû duïng chuùng phuï thuoäc vaøo töøng tröôøng hôïp phaân tích döõ
lieäu. 

Tröôùc heát ta seõ xem xeùt noäi dung cuûa leänh naøy. Khi choïn Query > SQL Select, hoäp
thoaïi SQL Select hieän ra. Hoäp thoaïi naøy thoaït nhìn coù veû phöùc taïp. Tuy nhieân vieäc naïp
caùc tieâu chuaån choïn vaøo caùc oâ khoâng phöùc taïp laém bôûi vì haàu heát caùc muïc ñeàu laø tuyø
choïn. Ví duï neáu ta khoâng muoán taïo ra toång phuï (sub-totals) thì haõy boû troáng oâ Group
By Columns. Hoäp thoaïi naøy bao goàm caùc noäi dung sau:

- Select Columns (Choïn caùc coät): cho MapInfo bieát nhöõng coät naøo seõ ñöôïc ñöa vaøo
baûng keát quaû. Theo maëc ñònh tröôøng naøy coù moät daáu sao (*). Daáu sao naøy cho
MapInfo bieát raèng caàn ñöa taát caû caùc coät trong baûng caàn choïn vaøo baûng keát quaû.
Neáu ta muoán baûng keát quaû chæ coù moät soá coät naøo ñoù trong baûng caàn choïn, haõy thay
theá daáu sao baèng danh saùch teân caùc tröôøng ta muoán ñöa vaøo baûng keát quaû, teân caùc
tröôøng caùch nhau bôûi daáu phaåy. Ví duï, khi thöïc hieän leänh SQL Select trong baûng
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cac_tinh, ta chæ muoán ñöa vaøo baûng keát quaû hai tröôøng laø teân tænh vaø daân soá chaúng
haïn, thì trong oâ naøy ta seõ goõ nhö sau:

Select Columns: Ten, dan_so

- From Tables (töø caùc baûng naøo): tröôøng naøy cho MapInfo bieát phaûi tìm döõ lieäu töø (caùc)
baûng naøo. Ta phaûi naïp teân cuûa ít nhaát moät baûng vaøo oâ naøy. Neáu ta muoán MapInfo
tìm kieám döõ lieäu treân hai hay nhieàu baûng, lieät keâ caùc baûng ñoù trong oâ naøy, teân caùc
baûng caùch nhau bôûi daáu phaåy. Neáu ta ñöa teân hay hai nhieàu baûng vaøo oâ naøy thì
trong oâ Where Condition ta phaûi cho MapInfo bieát caùch keát hôïp caùc baûng naøy vôùi
nhau nhö theá naøo. Neáu ta naïp teân hai baûng vaøo oâ From Tables, MapInfo seõ töï ñoäng
tính toaùn ñeå laäp bieåu thöùc trong oâ Where Condition. Tuy nhieân neáu ta söû duïng ba
baûng hay nhieàu hôn, ta phaûi töï ñieàu chænh laïi bieåu thöùc trong oâ Where Condition.
Khi thöïc hieän pheùp phoái hôïp nhieàu baûng, taát caû caùc baûng ñeàu phaûi laø baûng nguyeân
thuyû cuûa MapInfo. Ta khoâng theå söû duïng moät baûng keát quaû töø moät pheùp choïn tröôùc
ñoù (ví duï ta khoâng theå söû duïng Query1 ñeå laøm baûng phaân tích).

- Where Condition (ñieàu kieän): OÂ naøy ñöôïc söû duïng cho nhieàu muïc ñích khaùc nhau,
tuyø thuoäc vaøo baûn chaát pheùp choïn ta thöïc hieän. Khi ta thöïc hieän pheùp choïn treân moät
baûng duy nhaát, oâ naøy laø oâ tuyø choïn. Neáu ta thöïc hieän pheùp choïn treân hai baûng hay
nhieàu hôn, ta phaûi ñöa bieåu thöùc vaøo oâ naøy, vaø bieåu thöùc ñoù phaûi cho MapInfo bieát
caùch keát hôïp hai baûng vôùi nhau nhö theá naøo. Neáu muoán, ta coù theå ñöa tieâu chuaån
loïc döõ lieäu trong oâ Where Condition. Ñeå laøm ñieàu naøy caàn ñöa vaøo moât bieåu thöùc
luaân lyù (logical expression) maø keát quaû laø ñuùng hay sai (true/false). Ví duï khi choïn
döõ lieäu trong baûng cac_tinh, ta chæ muoán choïn nhöõng baûn ghi (haøng) naøo coù daân soá
lôùn hôn 500 nghìn ngöôøi thì trong meänh ñeà Where Condition ta seõ goõ nhö sau:

Where Condition: dan_so >  500

(ñôn vò tính trong coät naøy laø 1000 ngöôøi)

Khi goõ caùc con soá trong Where Condition, khoâng ñöôïc goõ daáu phaåy (daáu phaân caùch
haøng nghìn maëc ñònh trong heä Anh - Myõ).

- Group By Columns (Goäp nhoùm theo coät): OÂ naøy cho pheùp ta tính toång phuï trong
baûng keát quaû. Neáu ta ñöa vaøo oâ naøy teân cuûa moät tröôøng (hoaëc danh saùch teân caùc
tröôøng caùch nhau bôûi daáu phaåy), MapInfo seõ tính toång phuï cuûa baûng keát quaû vaø chæ
hieån thò caùc toång phuï chöù khoâng hieån thò töøng haøng ñöôïc choïn. Tính toång phuï laø
moät giai ñoaïn goàm hai böôùc:

1. Naïp teân (caùc) coät trong oâ Group By Column.

2. Naïp laïi teân (caùc) coät ñoù vaø caùc toaùn töû toång hôïp soá lieäu (ví duï nhö Sum (toång)
haøy Count (ñeám)) trong oâ Select Columns.

OÂ Group By Column laø tuyø choïn. Neáu ta boû troáng oâ naøy (maëc ñònh) thì MapInfo seõ
khoâng tính toång phuï.

- Order By Columns (Saép thöù töï): OÂ naøy cho pheùp ta saép thöù töï baûng keát quaû. Neáu ta
naïp vaøo teân moät coät (hoaëc nhieàu coät, teân coät caùch nhau bôûi daáu phaåy) vaøo oâ Order
By Column, MapInfo seõ xeáp thöù töï caùc haøng trong baûng keát quaû. Theo maëc ñònh,
MapInfo xeáp thöù töï caùc haøng theo chieàu xuoâi (coù nghóa laø A ñöùng treân B vaø soá nhoû
ñöùng treân soá lôùn). Neáu muoán xeáp thöù töï theo chieàu ngöôïc laïi, ta goõ chöõ “Desc”
(vieát taét cuûa chöõ descending - saép thöù thöï ngöôïc) sau teân coät. Ví duï:
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Order By Columns: dan_so  desc

OÂ Order By Column laø oâ tuyø choïn. Neáu ta boû troáng oâ naøy, baûng keát quaû seõ khoâng
ñöôïc saép thöù töï.

- Into Table Named (Vaøo baûng coù teân laø): OÂ naøy cho pheùp ta ñaët teân cho baûng keát
quaû. Theo maëc ñònh baûng keát quaû coù teân laø Selection. Neáu ta muoán ñaët cho baûng
keát quaû moät teân khaùc, haõy goõ teân ñoù vaøo oâ Into Table Named. Teân naïp vaøo oâ naøy
khoâng ñöôïc truøng teân vôùi caùc baûng ñang môû.

Neáu ta söû duïng leänh SQL thöôøng xuyeân trong moät phieân laøm vieäc vaø neáu ñeå
Selection laø teân cuûa baûng keát quaû thì sau cuøng ta seõ coù raát nhieàu baûng keát quaû ñöôïc
môû ra (ví duï Query1, Query2, Query3,...). Nhöõng baûng coù daïng Queryn naøy khoâng coù
haïi gì caû tuy nhieân moät soá ngöôøi chæ ñôn giaûn laø khoâng thích nhieàu baûng ñöôïc môû ra.
Neáu muoán traùnh khoâng cho moät soá löôïng lôùn nhöõng baûng Queryn ñöôïc môû ra, haõy naïp
moät teân khaùc vaøo oâ Into Table Named. Ví duï neáu ta ñaët teân trong oâ naøy laø
Ket_qua_chon: 

Into Table Named: Ket_qua_chon

thì moãi pheùp choïn SQL Select tieáp theo seõ söû duïng teân treân laøm baûng keát quaû. Baèng
caùch naøy ta chæ phaûi laøm vieäc vôùi moät baûng keát quaû duy nhaát (teân laø Ket_qua_chon),
baát keå ta thöïc hieän bao nhieâu laàn leänh SQL Select.
- Browse Results: (Hieån thò keát quaû): Neáu oâ Browse Results ñöôïc ñaùnh daáu choïn,

MapInfo seõ hieån thò keát quaû trong cöûa soå Browser.
Söû duïng caùc danh saùch thaû xuoáng: Beân phaûi hoäp thoaïi SQL Select coù 5 danh saùch

thaû xuoáng: Tables, Columns, Operators, Aggregates vaø Functions. Caùc danh saùch thaû
xuoáng naøy (môû caùc danh saùch ra baèng nuùt thaû xuoáng ) cho pheùp ta ñieàn thoâng tin
vaøo hoäp thoaïi SQL Select baèng caùch nhaép chuoät vaø choïn thay vì phaûi goõ leänh. Noùi caùch
khaùc caùc danh saùch thaû xuoáng naøy laø caùch laøm taét giuùp ta haïn cheá vieäc phaûi goõ leänh.
Ví duï neáu ta muoán naïp teân moät baûng vaøo oâ From Tables, ta coù theå thöïc hieän baèng caùch
nhaép chuoät vaø choïn.

- Save Template: Löu nhöõng gì ta ñaõ naïp trong hoäp thoaïi SQL Select thaønh pheùp choïn
maãu (Query Templates)

- Load Template: Môû moät pheùp choïn maãu ñaõ ñöôïc löu tröôùc ñoù.

Ñeå laäp ñöôïc bieåu thöùc ñuùng ñaén, ta caàn naém vöõng caùc toaùn töû, caùc töø khoaù cuõng
nhö caùc haøm soá trong MapInfo. Xem theâm trong Chöông XVIII, Haøm soá.

XII.1.3. Moät soá ví duï cuûa leänh SQL Select

Ta seõ xem xeùt “söùc maïnh” cuûa leänh naøy thoâng qua moät soá ví duï.

Ví duï 1: Haõy choïn caùc ñieåm daân cö naèm trong tænh Laøo Cai

Phaân tích: ta thaáy raèng caùch ñieåm daân cö naèm trong lôùp thanh_pho coøn tænh Laøo
Cai naèm trong lôùp cac_tinh. Nhö vaäy pheùp choïn naøy söû duïng thoâng tin töø hai tænh, keát
quaû choïn trong lôùp cac_tinh. Ta thöïc hieän pheùp choïn naøy baèng SQL Select nhö sau
(hình XII.4):
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- OÂ Select column: giöõ nguyeân daáu hoa thò (*), töùc choïn taát caû caùc coät.

- From table: thanh_pho

- Where Condition: obj within (select obj from cac_tinh where
cac_tinh.ten = "Laöùo Cai")

- Order by Columns: saép thöù töï theo coät ten.

Ví duï 2: Choïn nhöõng thaønh phoá trong caùc tænh coù dieän tích döôùi 2000 km2.

Phaân tích: caùc thaønh phoá - thò xaõ laø nhöõng ñieåm daân cö naèm trong lôùp thanh_pho,
coøn caùc tænh naèm trong lôùp cac_tinh. Trong lôùp naøy giaû söû ta khoâng coù coät dieän tích,
tuy nhieân ta vaãn coù theå thöïc hieän pheùp choïn naøy döïa treân tieâu chuaån dieän tích baèng

caùch söû duïng haøm soá ñeå laáy dieän tích töø
vaät theå vuøng (caùc tænh) tröïc tieáp töø

baûn ñoà. Hoäp thoaïi SQL Select coù
theå troâng nhö treân hình XII.5.

- Select Column: *

- From Table: thanh_pho

- Where condition: obj
within any(select obj

from cac_tinh where

Hình XII.4. Hoäp thoaïi SQL Select ñeå choïn (caùc) vaät theå töø moät
lôùp theo tieâu chuaån töø moät lôùp khaùc.
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area(obj,"sq km") < 2000)

Ví duï 3: Choïn taát caû nhöõng tænh coù soâng chaûy qua

Phaân tích: Caùc tænh naèm trong lôùp cac_tinh, caùc con soâng naèm trong lôùp song. Pheùp
choïn naøy traû veà keát quaû laø caùc haøng thuoäc lôùp caùc tænh nhöng coù tham chieáu ñòa lyù vôùi

caùc vaät theå trong lôùp song. Hoäp thoaïi SQL Select troâng gioáng nhö treân hình XII.6.

- From Table: cac_tinh,song

- Where Condition: song.Obj Intersects cac_tinh.Obj

Ví duï 4: Choïn nhöõng tænh coù soâng chaûy qua vaø chieàu daøi soâng nhoû hôn 50 km.

- From table: cac_tinh

- Where Condition: obj Intersects any(select obj from song where
ObjectLen(obj, "km")<50)

Trong pheùp choïn naøy, nhöõng tænh naøo coù töø hai con soâng chaûy qua trôû leân maø coù
moät con soâng coù chieàu daøi nhoû hôn 50 km thì tænh ñoù cuõng ñöôïc choïn.

XII.1.4. Löu pheùp choïn

Hình XII.5. Choïn vaät theå kieåu ñieåm theo tieâu chuaån töø
vaät theå kieåu vuøng (SQL Select).
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Nhö ñaõ trình baøy ôû phaàn treân, khi thöïc hieän pheùp choïn baèng leänh Select hay SQL
Select, MapInfo luoân löu giöõ nhöõng pheùp choïn ñoù trong suoát moät phieân laøm vieäc tröø khi
ta ñoùng baûng coù chöùa caùc vaät theå/baûn ghi trong pheùp choïn. Neáu ta khoâng ñaët teân cho
pheùp choïn trong oâ Store Results in Table (leänh  Select) hay into Table Named (leänh
SQL Select) maø giöõ nguyeân teân maëc ñònh laø Selection thì MapInfo seõ töï ñoäng ñaët teân
cho caùc pheùp choïn theo thöù töï laø Query1, Query2,...Khi thöïc hieän caùc chænh söûa treân
cöûa soå baûn ñoà nhö caùc leänh Combine, Split, ... MapInfo cuõng töï ñoäng löu laïi caùc vaät
theå/baûn ghi coù lieân quan ñeán caùc leänh treân thaønh caùc teân laø Query nhö vaäy. Neáu ta
thöïc hieän nhieàu laàn caùc leänh chænh söûa baûn ñoà baûn ñoà nhö treân trong moät phieân laøm
vieäc, MapInfo seõ ghi nhôù moät danh saùch raát daøi caùc query nhö vaäy vaø laøm cho maùy
tính chaïy chaäm. Vì vaäy ñeå giaûi phoùng caùc Query naøy, ta neân thöïc hieän leänh File > Close
Table vaø choïn taát caû caùc Query ñoù ñeå ñoùng chuùng laïi seõ laøm maùy tính chaïy nhanh hôn.
Ñoái vôùi nhöõng pheùp choïn coù yù nghóa ñoái vôùi coâng vieäc, ta neân ñaët teân cho chuùng thay
vì ñeå teân maëc ñònh laø Selection. Ngoaøi ra neáu ta coù yù ñònh söû duïng caùc pheùp choïn naøo
ñoù nhieàu laàn, neân löu chuùng laïi.

Caû hai pheùp choïn Select vaø SQL Select ñeàu coù theå ñöôïc löu laïi ñeå söû duïng sau
naøy. Khi löu moät pheùp choïn, MapInfo chæ löu thoâng tin veà caùc baûn ghi trong moät pheùp

choïn ñoù töø baûng naøo, döõ lieäu thöïc chaát vaãn
naèm trong baûng chính. Laàn sau neáu môû
pheùp choïn ñaõ ñöôïc löu ra, thì döõ lieäu trong
baûng chính seõ ñöôïc naïp ñoàng thôøi phaàn
choïn seõ ñöôïc hieån thò. Moät pheùp choïn khi

ñöôïc löu seõ bao goàm hai taäp tin, moät taäp tin

Hình XII.6. Choïn vaät theå trong moät baûng theo tieâu chuaån giao nhau
vôùi vaät theå trong moät lôùp khaùc (SQL Select).
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.tab vaø moät taäp tin coù ñuoâi môû roäng laø .QRY. Taäp tin .QRY chöùa thoâng tin veà pheùp choïn
töø baûng naøo vaø bao goàm nhöõng baûn ghi naøo. Caùch laøm: sau khi ñaõ thöïc hieän pheùp
choïn, treân menu chính choïn File > Save Query; hoäp thoaïi Save Query As Table môû ra;
ñaët teân cho pheùp choïn trong oâ File name roài nhaán nuùt Save.

Sau khi löu moät pheùp choïn maø ta di chuyeån baûng goác sang moät thö muïc khaùc thì
khi thöïc hieän leänh File > Open Table ñeå môû baûng ñoù ra, MapInfo seõ hieån thò moät hoäp
thoaïi coù teân Please Locate <teân baûng goác>.TAB (Tìm thö muïc chöùa baûng goác). Ta phaûi
choïn trong oâ Look in cuûa hoäp thoaïi naøy thö muïc môùi cuûa baûng goác thì MapInfo môùi môû
ñöôïc pheùp choïn ñoù. Neáu baûng goác bò xoaù ta khoâng theå môû ñöôïc pheùp choïn ñaõ ñöôïc
löu ñoù.

XII.2. TÌM KIEÁM THOÂNG TIN

XII.2.1. Leänh Find (Tìm kieám)

Leänh naøy tìm kieám moät vaät theå treân cöûa soå baûn ñoà döïa theo döõ lieäu trong moät
tröôøng naøo ñoù cuûa baûng MapInfo. Leänh tìm kieám chæ coù theå thöïc hieän ñoái vôùi nhöõng
tröôøng naøo ñöôïc ñaùnh daáu laø Indexed trong caáu truùc cuûa tröôøng. Xem theâm veà caáu truùc
cuûa baûng trong Chöông XVII. Khi tìm ra ñöôïc vaät theå treân cöûa soå baûn ñoà, MapInfo seõ
ñaùnh daáu vaät theå ñoù baèng moät bieåu töôïng do ta chæ ñònh.

Khi chæ ñònh tìm kieám, neáu MapInfo tìm ra nhieàu vaät theå coù cuøng döõ lieäu do ta chæ
ñònh thì noù seõ lieät keâ danh saùch taát caû nhöõng vaät theå coù cuøng tieâu chuaån tìm kieám ñoù
cho ta choïn.

Caùch thöïc hieän leänh naøy nhö sau:

- Môû cöûa soå baûn ñoà coù baûng chöùa vaät theå caàn tìm kieám.

- Töø menu chính choïn Query > Find. Hoäp thoaïi Find môû ra (hình XII.7).

- Trong oâ Search Table ta choïn töø danh saùch nhöõng baûng ñang môû baûng naøo ta caàn
tìm kieám; trong oâ for Objects in Column ta chæ ñònh tìm kieám trong coät (tröôøng) naøo.

- Phaàn Optional cho pheùp ta tinh chænh pheùp choïn baèng moät baûng kieåu ranh giôùi (ví
duï nhö baûng caùc tænh) naøo ñoù, ñöôïc khai baùo trong oâ Refine Search with Table vaø
moät tröôøng naøo ñoù cuûa baûng treân, khai baùo trong oâ using Boundary Name Column.
Ñaây laø phaàn tuyø choïn, ta coù theå khoâng caàn khai baùo gì neáu khoâng muoán.

- Mark with Symbol: chæ ñònh cho MapInfo ñaùnh daáu vaät theå tìm ñöôïc baèng moät bieåu
töôïng. Choïn kieåu bieåu töôïng baèng nuùt ñònh daïng bieåu töôïng.

- Nuùt Option cho pheùp ta thieát laäp moät soá tuyø choïn trong leänh tìm kieám, tuy nhieân phaàn
lôùn nhöõng tuyø choïn naøy lieân quan ñeán nhöõng baûng MapInfo coù ñòa chæ (Address), laø
kieåu baûng ta ít khi coù ñieàu kieän söû duïng.

- Thieát laäp caùc tieâu chuaån tìm kieám xong choïn OK. Hoäp thoaïi Find chuyeån sang moät
daïng khaùc (hình XII.8).

- Trong oâ troáng phía treân cuøng hoäp thoaïi naøy hieän ra teân tröôøng maø ta choïn tìm kieám.
Ta phaûi goõ giaù trò caàn tìm kieám vaøo trong oâ naøy.

- Naïp giaù trò caàn tìm kieám xong choïn OK.
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Neáu MapInfo tìm ra moät vaät theå phuø hôïp thì cöûa soå naøy seõ ñoùng laïi ñoàng thôøi cöûa
soå baûn ñoà seõ di chuyeån veà vuøng coù vaät theå ñöôïc tìm thaáy vaø vaät theå ñoù ñöôïc ñaùnh daáu
baèng moät bieåu töôïng do ta chæ ñònh trong phaàn Mark with Symbol.

Bieåu töôïng ñaùnh daáu ñöôïc veõ trong lôùp Cosmetic cuûa cöûa soå baûn ñoà, vì vaäy noù
khoâng aûnh höôùng gì ñeán baûng cuûa ta.

Neáu tìm khoâng thaáy giaù trò naøo
trong tröôøng ñöôïc chæ ñònh gioáng vôùi
giaù trò do ta naïp vaøo thì hoäp thoaïi naøy
khoâng ñoùng laïi maø noù hieän doøng thoâng
baùo “Exact match not found” (khoâng
tìm thaáy giaù trò naøo khôùp) ñoàng thôøi oâ
troáng phía döôùi lieät keâ danh saùch caùc
giaù trò döõ lieäu maø MapInfo cho raèng
gaàn gioáng vôùi giaù trò ta naïp vaøo ñeå cho
ta choïn. Neáu ta tìm ñöôïc giaù trò ñuùng
trong danh saùch lieät keâ thì nhaép chuoät
choïn noù roài choïn OK. MapInfo seõ ñaùnh
daáu vaät theå ta choïn baèng thuû coâng ñoù.

Neáu tìm thaáy nhieàu vaät theå coù
cuøng giaù trò vôùi giaù trò ta naïp vaøo hoäp
thoaïi naøy hieän ra doøng thoâng baùo
“Multiple Found” (tìm thaáy nhieàu vaät
theå) ñoàng thôøi lieät keâ trong oâ döôùi taát
caû nhöõng vaät theå coù cuøng giaù trò ñoù
cho ta choïn. Sau khi choïn xong ta
choïn OK thì vaät theå ñöôïc choïn seõ
ñöôïc ñaùnh daáu. Hình XII.8. Hoäp thoaïi Find, böôùc 2 -

naïp giaù trò caàn tìm.

Hình XII.7. Hoäp thoaïi Find, böôùc 1 - thieát laäp
tieâu chuaån tìm kieám.
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Khi ñaõ thöïc hieän tìm kieám moät laàn baèng leänh naøy neáu laàn sau ta thöïc hieän leänh Find
moät laàn nöõa thì MapInfo seõ chuyeån ngay vaøo hoäp thoaïi treân hình X.8 vì MapInfo coi
nhö caùc thieát laäp tìm kieám luùc ñaàu laø maëc ñònh. Muoán chæ ñònh laïi baûng hay tröôøng khaùc
ñeå tìm kieám ta nhaép chuoät vaøo nuùt Respecify ñeå quay laïi hoäp thoaïi ñaàu tieân vaø thieát laäp
laïi tieâu chuaån tìm kieám.

Veà öùng duïng, leänh naøy chæ coù ích khi ta tìm kieám moät thoâng tin naøo ñoù ñaëc thuø trong
moät cô sôû döõ lieäu lôùn, ví duï nhö tìm teân ngöôøi, teân ñöôøng, teân quaän, teân ñòa danh,...
Leänh naøy khoâng neân ñöôïc söû duïng ñeå tìm nhöõng vaät theå theo thuoäc tính trong tröôøng
döõ lieäu lieäu vì ña phaàn caùc tröôøng hôïp seõ traû veà nhieàu giaù trò (thoâng baùo “Multiple
Found”) vaø ta khoâng theå bieát ñöôïc neân choïn ñöôïc vaät theå naøo. Trong tröôøng hôïp tìm
kieám theo thuoäc tính maø nhieàu vaät theå coù, ta phaûi söû duïng leänh Select hay SQL Select.

Löu yù raèng tieáng Vieät theo boä maõ VNI cuõng khoâng hieån thò ñuùng trong caùc oâ giaù trò
trong hoäp thoaïi naøy vì vaäy phaûi goõ tieáng Vieät raát caån thaän neáu ta tìm theo teân baèng
tieáng Vieät. Ngoaøi ra khi tìm kieám khoâng ñöôïc, danh saùch ñeà nghò do MapInfo ñöa ra
cuõng khoâng hieån thò tieáng Vieät ñuùng vì theá raát khoù nhìn.

Ta seõ xem xeùt moät ví duï cuûa leänh naøy.

- Môû baûng cac_tinh ra. Cöûa soå baûn ñoà baûng cac_tinh ñöôïc môû.

- Töø menu chính choïn Query > Find. Hoäp thoaïi Find ñaàu tieân môû ra.

- Trong oâ Search Table ta choïn baûng cac_tinh; trong oâ for Objects in Column ta choïn
tröôøng ten. (Löu yù danh saùch tröôøng chæ lieät keâ nhöõng tröôøng naøo coù ñaùnh daáu
Indexed trong caáu truùc baûng).

- Nhaép chuoät vaøo nuùt chænh kieåu bieåu
töôïng ñeå ñoåi ñaùnh daáu thaønh ngoâi
sao maøu ñoû.

- Choïn OK.

- Hoäp thoaïi Find thöù hai môû ra.

- Giaû söû ta muoán tìm tænh Ñaék Laék, ta
seõ goõ vaøo oâ ten chöõ Ñaék Laéc (chöõ
thöïc söï hieän ra trong oâ ñoù laø
“eïaoäk Laoäc”). Giaû söû ta goõ sai
chöõ k thaønh chöõ c trong töø “Laék”
thaønh “Laéc” (hình XII.9).

- Choïn OK.

MapInfo khoâng tìm ñöôïc töø gioáng
chính xaùc trong tröôøng ten, noù hieän
doøng thoâng baùo “Exact match not
found” vaø lieät keâ ra moät danh saùch
ñeà nghò ñoàng thôøi ñaùnh daáu chöõ
maø noù cho laø gaàn gioáng nhaát, töùc
chöõ “eïaoäk Laoäk”. Trong ví duï
naøy ñaây laø chöõ MapInfo choïn ñuùng
neân ta giöõ nguyeân vaø choïn OK ñeå
keát thuùc.

Hình XII.9. Caùc giaù trò gaàn ñuùng vôùi giaù trò
caàn tìm ñöôïc lieät keâ cho ta choïn.
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MapInfo di chuyeån cöûa soå baûn ñoà veà tænh Ñaék Laék vaø ñaùnh daáu tænh ñoù baèng
moät bieåu töôïng hình ngoâi sao maøu ñoù taïi troïng taâm cuûa tænh Ñaék Laék.

Nhö ta thaáy, leänh naøy khoâng maáy tieän lôïi ñoái vôùi tieáng Vieät.

XII.2.2. Leänh Find Selection

Ñaây laø leänh cho pheùp ta tìm kieám vaät theå/baûn ghi ñang ñöôïc choïn.

Leänh naøy ñöôïc thöïc hieän baèng caùch töø menu chính choïn Query > Find Selection.
Leänh Find Selection chæ söû duïng ñöôïc khi coù ít nhaát moät vaät theå treân cöûa soå baûn ñoà hay
moät baûn ghi treân cöûa soå Browser, hoaëc moät baûn ghi treân cöûa soå bieåu ñoà ñöôïc choïn.
Ñoái vôùi cöûa soå Bieåu ñoà, leänh naøy chæ coù taùc duïng neáu ta choïn baèng nuùt leänh Graph
Select.

Ta coù theå choïn moät hay nhieàu vaät theå treân cöûa soå Browser nhöng coù theå khoâng thaáy
(caùc) vaät theå ñöôïc choïn treân cöûa soå baûn ñoà. Neáu sau khi choïn xong treân cöûa soå
Browser ta thöïc hieän leänh Query > Find Selection thì cöûa soå baûn ñoà coù chöùa baûng coù
vaät theå ñang ñöôïc choïn seõ laäp töùc thay ñoåi ñeå hieån thò caùc vaät theå ñang ñöôïc choïn.

Töông töï nhö vaäy neáu ta choïn moät hay nhieàu vaät theå treân cöûa soå baûn ñoà hay cöûa
soå Bieåu ñoà roài choïn Query > Find Selection thì cöûa soå Browser seõ nhaûy veà vò trí coù caùc
baûn ghi ñang ñöôïc choïn. Tröôøng hôïp tìm trong cöûa soå Browser neáu caùc baûn ghi ñöôïc
choïn caùch xa nhau thi cöûa soå chæ di chuyeån veà vaät theå ñaàu tieân maø thoâi. Ñeå thaáy heát
caùc vaät theå ñang ñöôïc choïn trong cöûa soå Browser ta thöïc hieän leänh Window > New
Browser Window vaø trong oâ Browse Tables cuûa hoäp thoaïi Browse Table ta choïn
Selection thì moät cöûa soå Browser môùi seõ môû ra lieät keâ nhöõng vaät theå ñang ñöôïc choïn.

Tuy nhieân, leänh naøy thöôøng coù lôïi khi ta thöïc hieän pheùp choïn caùc vaät theå hay baûn
ghi baèng bieåu thöùc töø leänh Select hay SQL Select. Khi thöïc hieän pheùp choïn xong ta
thöïc hieän leänh Query > Find Selection thì cöûa soå naøo ñang ñöôïc kích hoaït (baûn ñoà hay
Browser hay bieåu ñoà) seõ thay ñoåi ñeå cho ta thaáy caùc vaät theå/baûn ghi ñang ñöôïc choïn.
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